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MINIMUM SYSTEM REQUIREMENTS
Operating System: Microsoft Windows 98/ME/XP

Component: CPU/RAM: For Windows 98/ME, a 300 MHz Pentium II or com-
patible processor and 32 MB of memory (RAM); For Windows XP, a 333 MHz 
Pentium II or compatible processor, and 128 MB of memory (RAM)

Free Hard Drive Space: 150 MB prior to installation

Video: Super VGA (800x600) video adapter (1024x768 recommended); Hi-color 
(16-bit) color quality

CD-ROM Drive: For installation only. To use the CD back-up features, a CDR/
CDRW is required. This drive must be part of your system, as opposed to a drive 
that you access via a network. 

Note: The CD-ROM drive does not need to be Kodak-compatible unless 
you want to insert Kodak Photo CD pictures into your Scrapbooks.

Other: Microsoft Internet Explorer 6.0 or later. (A full install package for Internet 
Explorer 6.0 is provided if your system does not already have it.)

System Configuration: May require minor adjustments to the configuration of 
your operating system and/or updates to the hardware component drivers.

Printer Support: Works with most popular printers (monochrome and color) sup-
ported by Windows.

Internet Connection: To take advantage of the online features, a 56 Kbps or high-
er connection speed and an account with an Internet provider. 

Note:  User is responsible for all Internet access fees and phone charges.

Mouse: Microsoft compatible

Note: System requirements are based on requirements to run the Family 
Tree Maker program. System configuration may require minor adjust-
ments to the configurations of your operating system and/or updates 
to the hardware component drivers. As with all Windows programs, 
a faster processor, more RAM, and more free disk space will enhance 
performance.

© 2005 MyFamily.com, Inc., Ancestry.com, Genealogy.com, Family Tree Maker, World 
Family Tree, FamilyFinder, Family Archive, and InterneTree are trademarks of  

MyFamily.com, Inc.

It is a federal crime to copy the Family Tree Maker Version 2006 Quick Start Guide  
in whole or in part without prior written consent from MyFamily.com, Inc.
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30-Day Money Back Guarantee

If this product doesn’t satisfy your needs, return it to get your money back. 
MyFamily.com, Inc. reserves the right to change these terms and condi-
tions at any time, including the right to modify or discontinue the terms of 

Membership.

If you are the original purchaser, and you are not completely satisfied with 
Family Tree Maker, you can obtain a refund of the price you paid for the 
product (but not shipping and handling charges) by returning the entire 
product to: MyFamily.com, Inc., Returns Center, 193 South Mountain Way 

Dr., Orem, Utah 84058 

Returns must be made within 30 days of the date the product was shipped 
to you. Returns must be accompanied by a copy of the original packing slip. 
This enables us to locate your original order and process your refund. Please 
use the pre-printed return label provided with your packing slip and include 
a reason for the return. MyFamily.com, Inc. reserves the right not to process 

returns that do not comply with these requirements.
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WELCOME TO FAMILY TREE MAKER
Thank you for purchasing Family Tree Maker—the easiest and most complete 
resource for building your family tree. We want your first experiences to be satisfy-
ing and enjoyable, so please take a few minutes to read this Quick Start Guide. It 
contains important information about how to create your first Family File; how to 
use the convenient, built-in Help program; and how to obtain help online. 

INSTALLING FAMILY TREE MAKER
To use Family Tree Maker, you must install it on your hard drive. You cannot run 
it directly from the original CD-ROM. If you already have a version of Family Tree 
Maker installed on your hard drive, just install the new version over the old one. 
Don’t worry, this will not harm your Family Files, and you will not lose any data. 

Note: You will need 150 MB of free space on your hard drive prior to installing 
the program. 

1. If you are upgrading from a previous version, back up your personal Family 
Files by selecting Backup from the File menu. Then choose your backup 
method and follow the on-screen instructions. 

2. Insert the Family Tree Maker Installation Program CD-ROM into your 
CD-ROM drive.

Note: When the CD is inserted, Family Tree Maker may launch 
automatically. Simply follow the on-screen instructions to 
complete installation. If it does not launch automatically, 
follow the instructions below:

3. Click the Windows Start button and then select Run. 

 Windows displays the Run dialog box.

4. Type “D:SETUP” and then click OK. 

Note: The “D” in “D:SETUP” stands for drive D. If you are 
installing from a CD-ROM drive other than drive D, type 
that letter instead. For example, to install from drive E, 
type “E:SETUP”.

5. Follow the instructions on the screen to complete the installation. 

4
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During installation, you will see a dialog box entitled “Select Components.” These 
items are not required to run Family Tree Maker but are added features such as 
maps. If you wish to minimize the size of the installation, do not select them. If 
your hard drive has enough room, you can select any or all of them. If you wish to 
use any of these components at a later time, you will be able to install them directly 
from the installation CD. 

Note: Please be sure to read the License Agreement during installation. If you 
need to refer to it in the future, open the file named “license.txt” in the 
same folder where you installed Family Tree Maker.

Register Today to Receive Special Benefits
Be sure to register your Family Tree Maker software to receive these great benefits: 

• Search capability.

• Free personal homepage to publish and share your family history reports, 
photos, and more.

• Three months of free Internet backups for your Family Files.

• Discounts on future versions of Family Tree Maker.

• Special offers on other products.

Special Note about Electronic Registration
If you selected “Register Later” during installation, you can still recall the conve-
nient electronic registration form. 

1. From the Help menu, select Register Family Tree Maker.

2. Follow the instructions on the Product Registration window.

USING HELP IN FAMILY TREE MAKER
Family Tree Maker has a convenient, built-in Help program. At any time, you can 
access Help for the current window you are viewing or editing. You can also search 
the entire Help file.

Note: You can also obtain help at <www.familytreemaker.com/help>.
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Help for the Current View
Some computer keyboards have a row of numbered keys across the top called func-
tion keys, or F-keys. The function key labeled F1 can be used from many windows 
in Family Tree Maker to call up a related Help window. You can also call up related 
Help for a current window by going to the Help menu and selecting Current View.

Searching on Help
You can search the internal Family Tree Maker Help program by typing in a key 
word or phrase, then viewing or printing the resulting explanation to use as you 
work.

To open Family Tree Maker Help:

1. From the Help menu, select Search for Help on. Family Tree Maker opens 
the Help for Family Tree Maker dialog box. 

 The Help window contains three tabs:

• The Contents tab displays a list of Help topics arranged logically in 
chapters, like the table of contents of a book. Each chapter is identi-
fied by a book icon. You can double-click a book to see the contents 
of each chapter. For chapters with sub-chapters, double-click on the 
subsequent book icon (chapters) until you funnel down to individual 
Help topics. Read individual Help topics by clicking on the topic you 
are interested in. The topic will be marked with a question mark in a 
square and will appear on the right panel of the dialog box.

• The Search tab lets you search for words or phrases that may be con-
tained in a Help topic.

• The Index tab displays a list of all the index entries available in Family 
Tree Maker’s Help file. 

To find help using the Index tab:

1. Click the Index tab and do one of the following:

• Type the first few letters of the word you’re looking for—Enter the 
word, phrase, or topic you want to know more about in the field.  
You can find many useful topic pages by entering the keywords “add-
ing,” “creating,” “displaying,” “entering,” “individual(s),” or “merging.” 
As you type, the Help program scrolls to the closest match and high-
lights it. 

6
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• Click the index entry you want, and then click Display—This option 
lets you scroll through the index, searching for a specific term. You may 
want to use the above method to find the general location of the help 
word or phrase you are seeking. Once the keyword or phrase you’re 
looking for is highlighted, either double-click on the term or click 
Display.

  Family Tree Maker takes you to the corresponding window in Help. 
If there is more than one choice for your entry, Family Tree Maker 
may display a second dialog box. Simply make your selection and click 
Display again.

Navigating in Help
The built-in Help program makes extensive use of clickable links to take you to 
related topic pages. These links are easily identified because they appear in blue 
underlined text. Click on any link to go to a new topic page. Once there, you can 
click Back to return to the previous page.

The Help for Family Tree Maker dialog box has its own buttons at the top of each 
page. Use these options to move around within the Help program:

Hide/Show—Click to remove the Contents, Index, and Search tabs of your dialog 
box and reduce the size of the dialog box. When you click Hide and those tabs are 
hidden, the Hide button is replaced with the Show button. Click the Show button 
to re-open the hidden tabs side of the dialog box.

Back—Click to move back through the series of Help pages you have navigated 
using the blue underlined text links. When you get back to your original Help page, 
this option will be grayed out and unavailable. At that point, return to the Index 
tab of the Help dialog box.

Forward—After using the back button, you can click to move forward as far as you 
have gone in Family Tree Maker Help. 

Print—Click to print the currently selected Help page. A print dialog box will be 
displayed from which you can select any available options, then print the page to 
keep for future reference. 

Options—Click to display a submenu of additional options available for the cur-
rently selected Help page. 



9

Entering Your User Information
You can enter information that identifies you as the person who prepared the 
Family File. 

1. From the Tools menu, select User Information. 

2. Fill in the appropriate fields in the User Information dialog box.

Getting Started Tutorial
Family Tree Maker includes a Getting Started Tutorial, which explains how to begin 
using Family Tree Maker. With this tutorial, you will quickly learn how to use 
Family Tree Maker to organize, research, and share your family history. The Getting 
Started Tutorial is installed on your computer when you install Family Tree Maker.

1. From the Help menu, select Getting Started Tutorial.

2. Follow the instructions on the screen.

Getting Started Manual 
An Adobe Acrobat (PDF) version of the Getting Started Manual is included on the 
Family Tree Maker installation CD-ROM. During installation, you may choose to 
install these files on to your computer, or you may simply use the files on your CD-
ROM. 

To find and read your manuals:

1. On your computer’s desktop, double-click the My Computer icon. 

2. Double-click the icon labeled C: (the default drive for installing programs).

3. Double-click the Programs Files folder.

4. Double-click the Family Tree Maker 2006 folder.

5. Double-click the Manuals folder. You’ll find the Getting Started Manual 
(HandBook.pdf ) and the Quick Start Guide (FTMGuide.pdf ). Click to 
open the one you want. 

If you are not able to view the PDF version of the Getting Started Manual, 
you will need to install Acrobat Reader, which is available free from the 
Adobe website. 

8
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To download and install the Adobe Acrobat Reader:

1. Go to <www.adobe.com>.

2. Download the free Acrobat Reader and follow their instructions to install 
it on your system. You may need to restart your computer when Acrobat 
Reader has been installed. 

 The program will launch automatically when you click on any PDF file.

Technical Support
FamilyTreeMaker.com is a resource for answers to technical or customer service-relat-
ed questions. Here you’ll find easy-to-understand articles, tips, step-by-step instruc-
tions, and tools for using Family Tree Maker. From the Help menu, select Online 
Help Center, or go to <www.familytreemaker.com/help>. 

If you prefer, you can write to: MyFamily.com, 360 W. 4800 N., Provo, UT 84604. 
Please be aware that the minimum response time for written communication is four 
to six weeks.

STARTING FAMILY TREE MAKER 
After you install Family Tree Maker, the fun begins! This Quick Start Guide will 
show you how to build your family tree in just four easy steps.

Enter what you know—Start Family Tree Maker and create your first Family File.

Search for more ancestors—Use the power of the Internet and Web Search to 
search Ancestry.com and discover more family members to add to your file.

Create charts and reports—Use our tools to create beautiful, printable charts and 
reports.

Share with family and friends—Publish family books and put your work on the 
Internet for others to see. 

Let’s get started with step one—entering what you know. (Remember that after 
Family Tree Maker has been installed on your hard drive, you no longer need the 
installation disk in your CD-ROM drive.)
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To start Family Tree Maker:

1. Click the Windows Start button, or double-click the desktop icon and skip 
step 2.

2. From the Start menu, select Programs, then Family Tree Maker 2006, and 
then from the sub-menu, select Family Tree Maker 2006.

If this is your first time opening Family Tree Maker 2006 on this computer, Family 
Tree Maker will greet you with a one-time-only Welcome Screen. The Welcome 
Screen (see Figure 1) will let you view the Getting Started Tutorial if you have an 
Internet connection, as well as choose whether you want to create a new file or 
open an existing file (FTM, GEDCOM, or AFT). 

Creating Your First Family File
1. If you are a new user, click Create New to begin creating your very first 

Family File.

 OR

 If you are upgrading and already have a Family File you would like to open 
in this new version, select Open Existing and skip to step 5.

2. In the Name New File dialog box, enter a name in the File name field.

 Your file name can be as long as you want. We suggest a name like  
REED.ftw for the Harold Reed family, for instance. Family Tree Maker 
will automatically add the “.FTW” extension to the name you type.

Figure 1. Welcome Screen.
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3. If you want to save your new file to a different location, click Browse and 
choose a new location.

4. Click OK. The dialog box will close, and the Family View in Family Tree 
Maker will open. You are now ready to enter information in Family View. 
Skip steps 5 and 6.

5. In the Open Family File dialog box, select the type of file you want to open 
from the Files of type drop-down list, and then locate the file on your 
computer using the Look in drop-down list.

6. Click Open. The file will open in Family Tree Maker.

Entering Information in Family View
The Family View (see Figure 2) lets you enter information about a family unit 
(husband, wife, and children) in a format that makes it easy to see the relationship 
between members of a family. From a Family View, you can click to other Family 
Views, for example, you can click on the arrow button next to the parents or the 
children of the husband and wife to go to their Family View. You can also click the 
Edit button nearest the couple or children on the Family View to enter and view 
additional details about individuals.

Figure 2. Family View of James Clarence BOBBITT.
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1. In the Husband and Wife fields, fill in a couple’s names, using your mouse 
to click in each new field. We recommend beginning with yourself or your 
parents. Remember to use maiden names for females. Enter names in the 
following order: first name, middle name, last name.

2. Fill in the Birth date, Birth place, Death date, Death place, Marriage 
Date, and Marriage Place fields for the husband and wife, if known. 

3. Click in the Name field under Children and enter a child’s name. Family 
Tree Maker will automatically fill in the child’s last name for you based on 
the husband’s last name. If this is incorrect, you can continue to type over 
the suggested name. 

4. Click on each subsequent field in the row to fill in additional information 
about the child. Then, click in the Name field on the next row to begin 
entering another child’s name. All information you have entered will auto-
matically be saved.

 You can easily navigate to a new Family View to continue entering informa-
tion about individuals by clicking on the Parents button or clicking the blue 
arrow button next to a child’s name. 

Viewing Information in Pedigree View
While you can enter, edit, and view information in Family View and Pedigree View, 
the focus of Family View is entering information with limited navigation, and 
the focus of Pedigree View is navigating with limited editing. You can access the 
Pedigree View by clicking the Pedigree View button on the toolbar. 

Note: Do not confuse the navigable Pedigree View with the pedigree chart.

The Pedigree View (see Figure 3) consists of a tree that shows one individual fol-
lowed by the individual’s parents, then grandparents, then great-grandparents, then 
great-great-grandparents, and so on. 

Follow these steps to see some key features: 

1. Click on Generations at the bottom of the Pedigree View to select the 
number of generations you would like to view on the window at once, 
from three to seven generations.

2. Click the Index button in the Pedigree View Side Panel to see a list of all 
names that have been entered into the Family File. Click on a name in the 
Index to make that person the new root individual in the Pedigree View.

12
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3. Double-click on a name in the Pedigree View to open that individual’s Edit 
Individual dialog box.

4. Click on any field in the Pedigree View that reads “Add Mother” or “Add 
Father” to add their names.

5. Click the Spouses and Children button in the Pedigree View Side Panel to 
view the spouse and children of the highlighted individual in the Pedigree 
View.

6. Click the arrows to the right of the Pedigree View to navigate to ancestors 
that are in generations prior to the one on the current window. You can also 
do the same with descendants. 

Working with the Edit Individual Dialog Box
The Edit Individual dialog box (see Figure 4) enables users to view and record 
details about each individual in a dialog box that can be easily accessed from several 
areas of the program. The Edit Individual dialog box is multi-tabbed and can be 
accessed from the Edit button in the Family View, the Edit button in the Pedigree 
View, or the Edit Individual selection from the People menu. 

Figure 3. The Pedigree View, set to show 4 generations.
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The tabs include:

General—Includes the individual’s name, sex, title, birth and death dates 
and places.

Facts—Includes any additional general facts, such as adoption, immigra-
tion, education, military service, nationality, retirement, and so on.

Notes—Make notes about the individual, for example, stories passed down 
through the generations, experiences while researching, and so on. You 
should record source information in the Source-Citation dialog box, not 
the Notes tab; otherwise, the information won’t be included in reports.

Medical—Record height, weight, cause of death, and other medical infor-
mation. This is helpful for tracking a family’s health history.

Address—Record the individual’s address. This could be a current address 
or the last known address which may be helpful for tracking down indi-
viduals.

Figure 4. The Edit Individual dialog box for James Clarence BOBBITT.

14
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RESEARCHING YOUR FAMILY HISTORY AT HOME
Step two consists of researching and expanding your family history. Family Tree 
Maker makes this easy by providing powerful search tools; concise, accurate reports; 
and Internet links to genealogy-related websites from the Web Search window and 
the Internet menu.

Using Web Search
If you are connected to the Internet, Family Tree Maker will perform “behind-
the-scene” searches on the vast collection of genealogy records on Ancestry.com 
and look for potential ancestor matches. (If you are not online already, you will be 
prompted to connect to the Internet.) 

You can view a report about the records that Family Tree Maker finds by clicking 
the Web Search Resources button (see Figure 5) from the toolbar, the Family View, 
or Pedigree View.

Web Search Report

The Web Search report (see Figure 6) will list search results for the individual you 
last viewed. You will be able to see Quality stars, which show the likelihood of the 
match being successful, plus other details about each search result so you can  
verify if the match is for the correct individual. This also contains active links to 
Ancestry.com data collections to see more detailed information about the record or 
view an image of the record, if available. The result is that you can begin research-
ing and verifying the potential matches shown for the individuals in your Family 
File immediately. 

The Five-Star Ranking System

The five-star ranking system indicates the probability of a data match to an indi-
vidual in your file on a scale of one to five. Five-Star Matches appear in the first 
section of the report and are certain to contain information about someone in your 
Family File. One-Star Matches have the lowest probability of containing a match to 
an individual in your file, but they are still worth researching. 

Figure 5. The Web Search Resources button.
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Source Comparisons

This report also lets you compare, side-by-side, the information found online with 
the information already in your file. Online sources include census records; birth, 
marriage, and death records; land records; immigration records; military records; 
family and local histories, and others. All of these collections can be purchased by 
subscription, if you have not already purchased them with the Family Tree Maker 
package you purchased.

The Filtering System

The Web Search filtering system lets you filter out the results you don’t want to see 
again or set a flag to a promising record. Just click on the drop-down menu above 
the Quality column, the Source column, or the Status column to choose the item 
you want to be able to see (versus the other menu items, which will be filtered out.) 
To set a status for an individual, click on the row to select the individual, and then 
click on the small arrow that appears in the Status column to select an item from 
the status menu.

Figure 6. The Web Search window for James Clarence BOBBITT.

16
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Using Web Merge
Once you identify a relevant Web Search result, you can merge the information direct-
ly into your Family File. It’s always a good idea to back up your file before you merge 
in new data, but the Web Merge process will never overwrite any of your existing 
information. You can choose the pieces of information you wish to incorporate and 
whether that information should become the “preferred” or “alternate” information. 

1. Click on a result you would like to merge into your Family File. 
Information about that individual will appear in the Selected Person from 
Web Search box.

2. Click the Merge button. The Web Merge Wizard will launch.

3. Use the Back and Next buttons at the bottom of the Web Merge Wizard 
to go through the steps of the wizard.

Note:  On the Merge Primary Individual window, the three-column 
chart explains how the individual’s information will be merged. 
Use the first column to indicate if you want the results from 
Ancestry.com to be your preferred information, your alternate 
information, used as a source information for that name, or if 
you don’t want to add anything to your Family File. The mid-
dle column reminds you what you already have in your Family 
File, and the last column shows what you have chosen to do 
based on the first column. 

4. Verify your decision on the Summary Page. Then click Merge Now. The 
information will be merged into your Family File.

SHARING YOUR FAMILY HISTORY 
Now on to step three—sharing your family history with friends and family. After 
you have entered and researched names, dates, and other facts, you can use Family 
Tree Maker to create a variety of colorful trees and reports with just a click of your 
mouse. (You don’t have to enter your information twice; Family Tree Maker saves it 
for you and uses it as the basis for the reports and family trees.) You can even add 
a personal touch to trees by including pictures, by customizing the background, 
or by selecting one of the pre-defined templates included in Family Tree Maker. 
Scanned photos, text items, images from digital cameras or photo CDs—Family 
Tree Maker lets you add them all directly to your trees.
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If you don’t have electronic versions of your photographs, you can include empty 
boxes and attach your photos later by hand.

Creating Trees and Reports
To create a family tree or report, simply click on the Tree Charts or Reports button 
on the toolbar and select the appropriate tree or report from the drop-down menu 
(see Figure 7). You can also go to the View menu and select the type of tree or 
report you would like to create from the Tree Charts or Reports sub-menus.

Here’s a list of the trees and charts you can create:

Ancestor Trees (sometimes called “pedigree charts”) make great gifts for family 
members because they show an individual’s roots. Two parents, four grandpar-
ents, eight great-grandparents, and more are printed with perfect spacing. You can 
choose a Fit to Page Ancestor tree to get a one-page tree or a Book Layout tree or 
Custom Ancestor tree to get a multiple-page tree. Create an Ancestor Tree for your 
children or grandchildren they can cherish for years and pass on to generations to 
come. Ancestor Trees can be created in Fan, Standard, and Vertical formats.

Descendant Trees are ideal for family gatherings and reunions because they show 
where everyone fits in the family. Starting with a relative in the distant past, a 
Descendant Tree shows children, grandchildren, great-grandchildren, and so on. 
Descendant Trees can be created in Fan and Standard formats.

Figure 7. Selecting a tree chart from the Tree Charts button.
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Hourglass Trees, named for their general shape, combine the best of both Ancestor 
and Descendant trees. Starting from a selected primary individual in the middle 
of the tree, an Hourglass tree shows parents and grandparents branching above, 
and children and grandchildren spreading out below, in a compact arrangement of 
boxes. This is a perfect birthday gift for a parent or grandparent. Hourglass Trees 
can be created in Fan and Standard formats.

All-in-One Trees let you see everyone in your entire Family File and how they are 
related, rather than basing the tree on a primary individual. 

Standard Pedigree Trees can be printed as blank family tree forms—a helpful feature 
that will make your library research much simpler. Or you can photocopy the form 
and mail it to your relatives so you can confirm birth dates, wedding dates, and other 
vital statistics from distant branches of your family.

Reports are mainstays of family historians. Family Tree Maker lets you create a vari-
ety of reports about a single nuclear family, such as the Family Group Sheet. You 
can also create Genealogy Reports, Canon and Civil Kinship Reports, or design 
your own Custom Reports. Simply select the type and format you want, then 
print—Family Tree Maker does the work for you.

Pre-made Custom Reports let you create a variety of other graphical representa-
tions of your family file such as maps, timelines, calendars, and even mailing labels. 
They are accessible through the View menu.

Printing Trees and Reports
Once you have created your trees and reports, there are several ways to share them 
with friends and family. One way to do this is to simply print the tree or report 
on your printer by going to the File menu and selecting Print (name of tree or 
report). Or, click the Printer button and then click OK in the print dialog box.

Exporting Trees and Reports
Another way to share your trees and reports is to export them to an electronic file 
format that can be e-mailed or sent on a disk or CD to family members who do 
not have Family Tree Maker. 

The most effective way to share trees and reports is by exporting them as a PDF 
file. The PDF format, created by Adobe, is a universal file format. It’s a convenient 
way to prepare documents for uploading to a website, sending through e-mail, or 
printing at a service bureau (such as a copy shop or local printer), since anyone 
with Adobe Acrobat Reader can read or print the document. Plus, the document 
will look the same, no matter what kind of computer the recipient has.
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Some reports can also be exported to TXT, RTF, or CSV formats. TXT includes 
just the text of the report, without any formatting. TXT files can be viewed by 
almost any word processing software or by utility programs such as Microsoft 
Notepad. RTF files include text formatting and can be viewed, printed, and edited 
in many popular word processing programs including Microsoft Word. A CSV file 
saves information in a spreadsheet format. Many people find it useful to export a 
report from Family Tree Maker as a CSV file and then view, sort, print, and edit it 
in spreadsheet applications such as Microsoft Excel.

To export your trees and reports to a different electronic file format, go to the File 
menu and select Export (name of tree or report), and choose the correct format.

Creating Family Scrapbooks
Family Tree Maker lets you create individual multimedia collections called 
Scrapbooks (see Figure 8). Scrapbooks store almost any type of information, from 
sound, video, and text files to a variety of picture formats such as bitmaps, TIF files, 
JPEGs, and many others—even Kodak Photo CD pictures. In addition, you can 
select pictures from Scrapbooks to add to trees, reports, and Family Books. Each 
individual and marriage has a Scrapbook, so you can maximize your creativity as you 
gather and preserve a wonderfully complete collection of family history to pass on to 
future generations.

Figure 8. Scrapbook for James Clarence BOBBITT.



22

Creating a Family Homepage
Creating and uploading (sometimes called posting) a homepage to the Internet 
is easy to do. Click and follow the step-by-step instructions to automatically pro-
duce a professional-looking, fully integrated website for your family and friends to 
visit. Because other family researchers will also be able to find your homepage, you 
may make new friends and discover long-lost family members. Begin your Family 
Homepage by selecting Create a Family Home Page from the Internet menu.

So you can protect your family’s privacy, Family Tree Maker offers a way to priva-
tize your files so you can record essential information without making it public. 
This step hides all information except name, gender, and family links. Under the 
File menu, select Privatize File. Information entered in notes and book text items 
will not be privatized. Family Tree Maker also gives you options to exclude indi-
viduals you are posting to your homepage or privatize living relatives before posting 
to your User Home Page. Key Internet menu items include:

Update or Edit my Home Page—Launch a wizard to create your homepage. 

View my Home Page—Visit your homepage.

Add a Tree/Report to my Home Page—Select to display a fast and easy wizard for 
adding the report in an HTML version, a PDF version, or both. 

Note: You can have only five reports on your homepage at any one time. If you 
attempt to add more than this, Family Tree Maker will advise you to delete 
one before you can add another. 

Add a Picture to my Home Page—Display the Individuals with Scrapbook Pictures 
dialog box. The individuals listed here all have pictures in their Scrapbooks. Select 
an individual and click OK. Then, from the Insert Scrapbook Picture dialog box, 
you can select the picture you want to add to your homepage.

Creating a Family Book
Wouldn’t you love to have a printed family history to share your family stories, 
photographs, maps, and research? Family Tree Maker gives you the power to com-
bine your choice of printouts—from ancestor trees, kinship reports, and genealogy 
reports to maps, timelines, and more—into one continuous document. Family Tree 
Maker can automatically generate a table of contents and index, and you have a 
complete Family Book (see Figure 9). You can print and bind it to create a unique 
and treasured gift for your family to cherish for generations to come. You can also 
export it as a PDF file, as you can with trees and reports. The PDF file can then be 
e-mailed to your friends and family or published on your own homepage to share 
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with other family and friends. They will not have to own Family Tree Maker in 
order to view your Family Book.

Note:  You can have only one book on your homepage at any one time. If you 
attempt to add more than this, Family Tree Maker will advise you to delete 
one before you can add another.

To create a book using the Online Books Tutorial:

1. From the Help menu, select Books Tutorial. You must be connected to 
the Internet to view the tutorial. 

Key items under the Books menu include:

Create a Family Book—Create an heirloom-quality book to showcase your family 
history for present and future generations. Use the Books menu to create your book 
in a matter of minutes. If you need help, simply connect to the Books Tutorial to 
view easy, step-by-step instructions. 

Open Book—Displays the Books window. From here, you can add or remove 
items, change the order of their appearance, and explore many other book custom-
ization features.

Publish a Book on Your Home Page—Easy step-by-step instructions for adding 
(uploading) a Family Book to your personal homepage. 

Figure 9. The Book window.
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THANK YOU
Thank you for purchasing Family Tree Maker, and welcome to the exciting world 
of genealogy. We know Family Tree Maker will provide many hours of enjoyment 
as you record and preserve your own family heritage for generations to come. 
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